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The following document describes, in detail, the features and content of Microsoft® MapPoint® 2004 business mapping software, which is available in North American and European editions. Each feature description is accompanied by a sample scenario or use. Features are grouped into three main benefit categories:

1. Visualizing business data

2. Communicating business information more effectively using maps

3. Integrating maps into the work done with Microsoft Office

Visualizing Business Data

Data Mapping Wizard

The Data Mapping Wizard helps users turn a myriad of business data into useful maps with impact. Step-by-step instructions guide users on how to import their business information, apply demographics, and choose the right map type and the best way to display the information. 
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The first panel of the wizard describes the nine types of maps that can be produced using MapPoint 2004. Users can choose from Shaded Area map, Sized Circle map, Shaded Circle map, Multiple Symbol map, Pie Chart map, Sized Pie Chart map, Column Chart map, Series Column Chart map or Pushpin map. Descriptions of each type of map and how it can be used accompany this panel so that even inexperienced mapmakers can create professional-looking visuals.

Users are then walked through the process of selecting the type of data to be mapped and either linking or importing the data into MapPoint. Once a data set has been selected, the wizard displays the data — either a list of demographics, or columns or fields of data to be mapped — available for mapping and allows users to control the level of geography at which the data is displayed. 

Finally, the Data Mapping Wizard enables users to select the color, symbol, number of data increments and data range. Although MapPoint calculates a default data range, users can enter values manually to modify the map.

Data Mapping With Charts

To enhance the effectiveness of maps for business analysis, MapPoint 2004 enables users to include deeper levels of information through the addition of pie charts and column charts. Each type of chart provides a different view of information.

· (Equal size) Pie Chart map shows each segment’s contribution to the sum. It is useful for representing information such as each product’s share of the company’s total revenue.

· Sized Pie Chart map is similar to the Pie Chart Map; however, the size of the Sized Pie Chart map pie corresponds to the size of its total value. It is useful for showing differing sales by sales territory and the makeup of each territory’s sales by product.

· Column Chart map shows vertical columns of varying size and color. It is useful for comparing different groups of information, such as service satisfaction level by metro area.

· Series Column Chart map is similar to the Column Chart map, but the Series Column Chart map shows the progression of a single variable, which is useful for demonstrating sales of a product over time for a region.

Demographic Data

MapPoint 2004 ships with more than 200 demographic and consumer profile variables in the United States and more than 50 in Canada from data supplied by Applied Geographic Solutions Inc. (AGS), Simmons Market Research Bureau Inc. and Compusearch Software Systems Inc.
· Demographics. MapPoint 2004 North America contains nearly twice as much demographic data as the previous version, giving users the ability to get data and analyze trends using such variables as crime, commute times, household expenditures, household size, education, marriage and divorce statistics, house values, and population. This data is sourced from one of the premier demographic data suppliers, AGS.
· Consumer behavior. MapPoint 2004 includes a set of new consumer purchase behavior data that is only available through the MapPoint 2004 product. Sourced from a leading marketer, Simmons Market Research, this information is derived from interviewing more than 20,000 U.S. households twice a year; sophisticated statistical methods are then used to project these results to the various geography levels available in MapPoint, including the census-tract level. Variables include the following: 

	· Automotive club membership

· Book/CD purchases

· Casino gambling

· Convenience store usage  
· Credit card shopping habits

· Department store shopping habits

· Electronic store shopping habits

· Home shopping: catalog, online, phone

· Insurance plans used

· Investment patterns

· Likeliness to respond to cash or coupon incentives

· Movie, live theater and concert attendance


	· Ownership of electronics

· PC usage: connection type, personal banking, online shopping

· Prescription and nonprescription medical product usage

· Supermarket shopping habits

· Travel, vacations, frequent flyer program participation

· TV services: cable, satellite

· Types of loans used

· Vehicle ownership and vehicle most likely to purchase

· Yellow Pages usage




Users can map demographic and consumer data by state, county, metropolitan statistical area, ZIP code and census tract in the United States, and by province, forward sortation area (FSA), census division and census subdivision in Canada. Many variables can be categorized by different time periods (such as 1990, 2000 and the current year), making it easy to analyze trends over time. In addition, Microsoft Corp. provides an additional 45 country-level variables around the world. 

The addition of demographic data enhances business analysis. By combining corporate information with market statistics, knowledge workers can more effectively see trends and opportunities, and make better business decisions.

Import (or Link) Data Wizard
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This wizard facilitates importing or linking business information stored in Microsoft Excel, Microsoft Access, the Microsoft Outlook® messaging and collaboration client, Microsoft SQL Server™, or delimited text files. When information is brought into MapPoint, MapPoint analyzes the data and discerns recognizable geographic fields such as street addresses, ZIP codes, cities, states, counties or countries. Users are prompted to choose the data fields they want to map and then are directed to the Data Mapping Wizard to complete the mapping process.

For records that MapPoint is unable to match, a “disambiguation” dialog box appears that offers users possible alternative matches for the data imported.

Drag and Plot

As expected in a Microsoft Office product, MapPoint 2004 supports the ability to drag data from one source or application and drop it into another. For example, a Microsoft Excel user can highlight data on a spreadsheet, drag the selection into MapPoint 2004 and drop it on the map. MapPoint would recognize the task and automatically launch the Import Data Wizard.

Territory Wizard

Businesses commonly use the idea of a territory or region to designate a specific geographic area. Territories are created by grouping together geographic areas served by a common resource, for example a sales territory, field district or management responsibility. MapPoint 2004 enables users to create custom territories based on geographic levels such as ZIP code, county, state or country. Users can import territory information from Excel or Access, or manually create territories on the map. 
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Once a territory is created, users can overlay their business information onto it and analyze their business by custom territory. The Territory Planner enables sales managers to plan and assign sales territories to specific sales representatives, analyze the sales performance of each representative’s territory, and balance representative responsibilities based on size of territory, competitive landscape and business opportunity.

Find Addresses and Places
MapPoint 2004 enables users to find an address or place quickly and easily. Users can either type in an address or place in the address field in the top toolbar, or click on Find to launch the Find Wizard. From there, users can type a street address, city, state or ZIP code to automatically locate the address or place on the map. Misspellings, omissions and multiple address listings are handled intelligently as part of the Smart Find technology in MapPoint. If the match is unambiguous, MapPoint will zoom the associate map to the best map view of the location.

Point-to-Point Routing

Users can get address-to-address driving directions for virtually anywhere in the United States or Canada (this feature is also available in MapPoint 2004 Europe for France, Germany, Italy, Spain and the United Kingdom). The Route Planner enables users to view, add, delete or rearrange their destinations. A new feature of MapPoint 2004 is the rendering of one-way streets with arrows. Complex directions — such as those including a rapid succession of turns — are placed on one direction line to prevent key instructions from being missed. Routing also offers customized options that let users choose driving speed, preferred roads and preferred routes (e.g., the shortest or quickest). MapPoint will also optimize users’ routes if they have multiple destinations.
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Drive-Time Zones

Users can turn simple routes into an analysis tool by generating drive-time zones to and from a specific location. A drive-time zone is the area within a perimeter that is created around a specified point to indicate all points that can be reached by car in a specified amount of time. This feature enables MapPoint 2004 users to identify a region and clients within convenient driving time of a location, which is important for planning delivery or service areas. Drive-time zone analysis is incredibly useful for a restaurant considering adding delivery service to its business model or for sales representatives who want to visit clients within a 60-minute drive of their head office, for example.

Flat Maps

MapPoint 2004 gives users a different perspective on the world by allowing them to view the world in a flat-map projection, a feature that was introduced in MapPoint 2002. This enhancement is on by default: Users simply open a new map and zoom out to see a map of the world on one screen. Anyone mapping worldwide data will greatly benefit from this feature because all the data can be viewed without having to rotate the globe. The globe view from MapPoint 2001 is still available. It can be changed by clicking on Globe View When Zoomed Out on the View menu. 

Communicating Business Information More Effectively Using Maps
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Custom and Multiple Symbol Pushpins

Pushpins designate a specific map location and are a core feature of MapPoint. Although 316 general symbols are included in MapPoint 2004, many users have indicated the need to customize symbols to accurately represent or identify a location on the map. MapPoint 2004 extends custom pushpin functionality to allow users to create pushpin icons and import them as BMP or ICO files. The symbols are saved and can be reused in the application. 

Multiple Symbol Pushpin maps are a variation of the Shaded Circle map, with each symbol representing a unique category of data. 

Custom and Multisymbol Pushpin maps are ideal for companies that want to show their competitive landscape, using corporate icons or logos to denote different business locations (e.g., stores, restaurants, gas stations or banks). Sales managers can also use multiple symbol maps to represent areas or locations that show sales growth (green circles), slow sales performance (yellow circles) or negative sales (red circles). This would enable them to immediately home in on problem areas and determine the cause and action needed.

Multiple Field Balloons

With pushpin balloons, users can now display multiple fields of data. This is a great way to show monthly or yearly sales together in one location. There are two ways to access this feature: 

· When users are creating a Pushpin map, the last dialog box of the Data Mapping Wizard allows them to select which fields will be visible in the pushpin balloons and whether the field names will also be visible. After their data is mapped, they select a pushpin on the map and click on Show Information in the View menu. They will see the field names they checked along with the corresponding data for the selected pushpin. 

· After users have mapped their data, they can right-click on the name of their mapped data set in the Legend and Overview pane, and click on Properties in the context menu that appears. On the Balloon tab in the Set Properties dialog box, they select the check boxes for the fields they want to display. 

Save as Web Page

MapPoint 2004 contains feature enhancements that enable MapPoint maps to be more dynamic and useful to people who may not have MapPoint installed. These features make it possible for maps to be incorporated as part of an existing Web page and for users to drill down into a map to get more detail via hyperlinks.

The enhanced Save as Web Page feature will enable businesspeople to do the following:

· Share business information, such as sales performance, over a corporate intranet

· Show location information, such as meeting places, company events or business location, on the Internet to external customers

· Deliver dynamic maps through a digital dashboard component

MapPoint 2004 also enables users to save a static map as an HTML file. This option renders a basic Web page with the map, legend information and driving directions (if appropriate).
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Drawing Tools and Map Annotations

Consistent with the tools users of other Microsoft Office family applications have come to expect, Microsoft MapPoint 2004 offers a set of drawing tools that allows users to customize their map. Microsoft MapPoint 2004 has adapted these tools to make them specific to annotating a map. For example, users can place their drawing object behind the roads on a street-level map. Map annotations may include the following:
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Scribble. Users can drag a mouse to draw lines of any shape.
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Line. Users can draw straight lines.
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Arrow. Users can draw straight lines with an arrowhead.
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Freeform. Users can draw lines of any shape and close them to fill them with color.
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Rectangle. Users can draw rectangles or squares. 
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Text Box. Users can draw rectangles and squares into which they can type text.
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Oval. Users can draw an oval by dragging a box to define the bounding rectangle for the oval. They can hold down the Shift key to constrain it to a circle.

In addition, MapPoint includes special drawing tools that are not available in other Office applications. They include the following:
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Pushpin. Users can click on a point on the map to place a pushpin there. They can choose one of more than 300 symbols to represent their pushpin.
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Highlighter. Users can draw a highlighted line to show a route or other feature on the map. The length of the highlighted line is shown on the map in miles or kilometers. 

Radius. Users can draw a circle by selecting a center point and then dragging out from that point to create the desired radius.

As in Office, the drawing tools in MapPoint create objects that can be copied, deleted or edited. All the closed shapes can be filled in with a solid color. The color can also be set for any lines or text. In addition, the line styles and text fonts are easily edited. MapPoint even includes an arrow line style that is especially useful for map annotation. 
Better yet, MapPoint allows users to overlap as many drawing objects as they want because there’s a tool to rearrange the order in which they are layered. They can even make the roads their top layer so that the drawing objects don’t obscure them.

Customized Output

With MapPoint 2004, users can print out their map and take it with them or share it with others. If they are printing out a route or directions, they can choose from five map styles, including strip maps with directions, turn-by-turn maps, directions only, map overview and the new full-page map that prints to the edge of the printout. Users can change map orientation and size and quality of the map printed, and include or exclude legend information. MapPoint includes the ability to print faxable maps that render the image in grayscale.

Output to Pocket Streets

MapPoint 2004 will run on Pocket PC 3.0 and higher, and has been updated to run on the next version of the Pocket PC software, Windows Mobile™ 2003, as well as Pocket PC Phone Edition-based devices. It now also supports Global Positioning System (GPS). Owners of Pocket PC devices can cut a piece of a street map generated in MapPoint, save it and download it to their mobile device. Using Pocket Streets, which is available on the MapPoint CD or from the Pocket PC Web site (connect-time charges may apply), users can interact with the map — look up addresses, pan, zoom and reference any pushpins they may have exported along with the map. Now mobile professionals can not only carry a list of customers with them on their Pocket PC, they can carry maps of each of their locations, along with contact details.

GPS Support

Both MapPoint 2004 and Pocket Streets, which ships with MapPoint, support GPS, including any GPS device running NMEA 0183 version 2.0 or later on COM Port 20 or below. Users simply plug the device into their laptop running MapPoint, and MapPoint will synchronize the position so they can see their location on their computer screen. Both MapPoint and Pocket Streets now check the GPS device for location information every second, giving users real-time GPS capabilities and the ability to find their exact location on the road. 

Integrating Maps Into Work Done With Microsoft Office

Office Add-Ins and Smart Tags
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MapPoint 2004 includes an Office add-in feature that places MapPoint buttons and menu commands on all users’ Office 2000 and Office 2003 applications. This enables easy access points from Office applications that open basic mapping functions such as data mapping or address find.
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MapPoint 2004 also integrates with Office 2004 using a smart tag feature. In Word, for example, users can hover their mouse pointer over an address or other place in their document and then click on Insert MapPoint Map on the Smart Tag button that appears. In Excel, users can hover their mouse pointer over a geographic heading and then select Export to MapPoint to create a MapPoint map of their geographic data.

Output to Microsoft Word, PowerPoint® and Publisher

Users can easily copy and paste their maps into monthly reports and business presentations and proposals, or incorporate maps into custom brochures and sales collateral. They simply draw a box around the map image they want to replicate, right-click on it to copy it, open the destination file and paste the image. They can even resize the map.

Automation Support

Users can automate nearly everything that is available in the application. Specific enhancements that users have asked for include the ability to find close matches for address matching and, using the FindResults and FindAddressResults methods, events on the Application and Map objects, as well as inclusion of the ActiveX® Control (see the next section for more information on the control). Features include the following:

· Drawing tools automation (shapes)

· Toolbars

· Find and location enhancements

· Routing and directions

· Selection

· Window management

· Driver profile

· Page setup and printing

· Full clipboard support

· Demographic maps

· All the new MapPoint 2004 features 
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ActiveX Control

Users can integrate MapPoint maps into a Microsoft Visual Basic® development system-based application. From Visual Basic, users can click on Components on the Project menu and add a reference to the Microsoft MapPoint Control 9.0. The MapPoint icon is added to their control toolbox. They can then add a MapPoint map to a form as easily as adding a button. Once they have added the control, the object browser shows the entire MapPoint automation, which they have access to through the MapPointControl object. They can seamlessly embed subsets of MapPoint functionality, including the ability to export maps to Pocket Streets, into customized solutions. 
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COM Add-Ins
COM Add-Ins increase business operation efficiency by applying customized applets to MapPoint, making it an extensible platform for solution providers. MapPoint 2004 registers with Visual Studio® .NET 7 and 7.1, so that add-ins can be created easily. Also, any add-ins can now be installed for all users. 

Data Source Support

MapPoint 2004 supports a variety of data formats, including the 97 or later versions of Microsoft Access, Microsoft Excel and Microsoft Outlook as well as Microsoft SQL Server 6.5 or later databases, delimited text and most databases accessible through OLE DB and ODBC.

Insert Map Object/In-Place Editing

During application installation, MapPoint 2004 registers itself as an OLE object that can be inserted and edited within other Office applications or OLE container applications. This functionality enables business users to insert and link maps into another Office application, and easily make changes to the map by double-clicking on it.
Enhanced Data Export to Excel

MapPoint makes it easy for users to select data that has been mapped and export that data to a Microsoft Excel spreadsheet. Users simply select a piece of the data map by holding down the left mouse button and drawing a box or other shape around it, and then select Export to Excel from the toolbar.

Office User Interface

Microsoft MapPoint offers users the familiar design and functionality of an Office application. With familiar menus, toolbars, ToolTips, and help facilities, new users of MapPoint will appreciate the user-friendly Office interface they have come to know.

#########
© 2003 Microsoft Corp. All rights reserved.

Microsoft, MapPoint, Outlook, Windows Mobile, PowerPoint, ActiveX, Visual Basic and Visual Studio are either registered trademarks or trademarks of Microsoft Corp. in the United States and/or other countries.

The names of actual companies and products mentioned herein may be the trademarks of their respective owners.
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